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Introduction  
Microsoft Visio 2007 helps users create professional-looking diagrams for understanding, 
documenting, and analyzing information, data, systems, and processes. The new features and 
enhancements in Visio 2007 make creating diagrams even easier and faster. This handout 
includes step-by-step instructions on how to work with shapes and text, connect and group 
shapes, and print the final diagram. It also included a brief introduction to systems thinking and 
process mapping, including how to select a process and the procedure of process mapping. 

Downloading the Data Files 
This handout includes sample data files that can be used for hands-on practice. The data files are 
stored in a self-extracting archive. The archive must be downloaded and executed in order to 
extract the data files. 
 
The data files used with this handout are available for download at 
http://www.calstatela.edu/its/training/datafiles/visio2007.exe.  
 
Instructions on how to download and extract the data files are available at 
http://www.calstatela.edu/its/docs/download.php. 

Introduction to Systems Thinking and Process Mapping 
Process mapping is a crucial tool for systems thinking. The participants in a process, the 
information gathered and action taken, as well as how that information flows throughout the 
system, can be identified in process mapping. 

PROCESS MAPPING 
Process mapping is a workflow diagram used to bring forth a clearer understanding of a process 
or a series of parallel processes (see Figure 1). A process map is also called a cross-functional 
flowchart or deployment chart. It visually depicts the sequence of events to build a product or 
produce an outcome. It is a visual representation of a process that illustrates: 

• What activities are completed by whom and in what sequence. 
• Hand-offs between departments or individuals. 
• Internal and external operational boundaries (swim lanes). 
• Clear starting and stopping points. 

Procedure of Process Mapping 
1. Select the process and define the process boundaries (define start and stop points). 

a. Write down three issues you have been confronted with recently. 
b. Select the most important issue. 
c. Why is this so important? 
d. What is the origin of this issue? 
e. What will it take to minimize or eliminate this issue? 
f. Draw a simple (high level) flowchart of the process involved. 

2. Create the “as is” process map. 
a. List all participants down the left side of the process map. 
b. Visually observe each step taken or repeatedly ask “what happens next?” 
c. Record a brief description in the appropriate row moving left to right with time. 
d. Connect the boxes in the order of flow. 

http://www.calstatela.edu/its/training/datafiles/visio2007.exe�
http://www.calstatela.edu/its/docs/download.php�
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3. Create the “could be” or “should be” process map.  
a. Analyze the current process for “non-value added” step elimination. 
b. Document the changes by creating a second process map. 
c. Seek approval from all groups. 

4. Implement the changes and train those involved in the process. 
5. Validate improvements by collecting performance data. 
6. If necessary, modify the process further until ultimate efficiency is reached. 

 

  
Figure 1 – An Example of a Process Map 

Process Mapping Using Microsoft Visio 
While Microsoft Word and PowerPoint provide basic diagramming capabilities, Visio is a 
dedicated drawing program that can help users easily create a broad range of drawings. 

STARTING VISIO 
To start Visio 2007: 

1. Click the Start button, point to All Programs, point to Microsoft Office, and click  
 Microsoft Office Visio 2007. 

USING THE INTERFACE 
When Visio starts, the application window displays the Template Categories pane on the left 
and the Getting Started with Microsoft Office Visio pane on the right (see Figure 2). 
 
By having templates organized into categories of related diagram types, Visio allows users to 
easily select the appropriate template (see Table 1 for a list of available template categories in 
Visio). The number of templates available in each template category varies. Once a category is 
selected, the available templates for that category are displayed. After selecting the desired 
template, Visio creates a new drawing and displays the Shapes pane. The Shapes pane contains 
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the stencils associated with the selected template (see Figure 3). Just as templates are organized 
by categories, related shapes are organized by stencils. For example, when users select the Home 
Plan template from the Maps and Floor Plans template category, all of the basic house 
structure shapes included with the template are organized in the Walls, Shell and Structure 
stencil. 
 

 
Figure 2 – Visio Interface 

 

 
Figure 3 – Drawing Window with the Shapes Pane Displayed 
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Table 1 – Available Template Categories in Visio 

Category Purpose 
Business To show business processes using brainstorming diagrams, 

organization charts, cause and effect diagrams, data flow 
diagrams, work flow diagrams, etc. 

Engineering To create basic electrical diagrams, circuits and logic 
diagrams, industrial control systems diagrams, fluid power 
diagrams, part and assembly drawings, etc. 

Flowchart To create basic flowcharts, cross functional flowcharts, 
work flow diagrams, etc. 

General To create basic diagrams, flowcharts, and block diagrams. 
Maps and Floor 
Plans 

To create two-dimensional or three-dimensional directional 
maps, floor plans, home plans, office layouts, plumbing and 
piping plans, etc. 

Network To create network designs using network and computer 
equipment shapes, Web site maps, etc. 

Schedule To track project details with calendars, timelines, Gantt 
charts, and PERT charts. 

Software and 
Database 

To create database model diagrams, UML model diagrams, 
Windows XP user interface diagrams, etc. 

Using Page Setup 
The Page Setup dialog box is used to customize printed drawings (see Figure 4). It is helpful to 
customize the printer paper size and the drawing page before starting the drawing in order to 
better arrange the space. The Print Setup and Page Size tabs are explained in detail in the 
following sections. 

USING THE PRINT SETUP TAB 
The Print Setup tab provides several settings that users can adjust, such as the printer paper size 
and orientation. Gridlines can be chosen to print when measurements are important in the 
drawing. The Print zoom area enables users to reduce or enlarge the printed size of the drawing. 
 
To change the paper orientation and the printed size of a drawing: 

1. Open the “print.vsd” file. 
2. Click the File menu and select Page Setup…. The Page Setup dialog box opens (see 

Figure 4). 
3. Click the Print Setup tab, if necessary. 
4. Under Printer paper, select the Landscape option button. 
5. Under Print zoom, click the Adjust to drop-down arrow  and select 50%. 
6. Under Print, select the Gridlines check box. 
7. Click the OK button to confirm the changes. 
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Figure 4 – Page Setup Dialog Box (Print Setup Tab) 

USING THE PAGE SIZE TAB 
The Page Size tab allows users to adjust the page size and set the page orientation to be either 
portrait or landscape for the drawing. 
 
To change the page size and orientation: 

1. Click the File menu and select Page Setup…. The Page Setup dialog box opens.  
2. Click the Page Size tab (see Figure 5). 
3. Under Page size, select the Pre-defined size: option button. 
4. Under Page orientation, select the Landscape option button. 
5. Click the OK button to confirm the changes. 

 

 
Figure 5 – Page Setup Dialog Box (Page Size Tab) 
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Using Basic Drawing Skills 
Visio allows users to create a drawing in several ways, including using a wizard which provides 
guidance for creating a drawing. The easiest way to create a drawing is to click on a template 
category and select a template.  

ADDING SHAPES TO A DRAWING 
To add a shape to a drawing, simply drag the desired shape onto the drawing page.  
 
To add a shape to a drawing:  

1. Click the File menu, point to New, and select Getting Started…. The Getting Started 
window displays. 

2. From the Template Categories pane, select the General category. All the templates in 
that category display in the right pane (see Figure 6). 

3. Select the Basic Diagram template.  
4. Next to Measurement Units:, select the US units option button. 

 

 
Figure 6 – Creating a Drawing from the Basic Diagram Template 

 
5. Click the Create button. The drawing page displays. 
6. In the Shapes pane, select the Basic Shapes (US units) stencil, if necessary. 

7. Drag the Square shape  onto the drawing page (see Figure 7). 
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Figure 7 – Adding a Square Shape to the Drawing Page 

SAVING A NEW DRAWING 
When a drawing is saved for the first time, Visio opens the Save As dialog box, into which users 
enter the desired file name and location. A file name can consist of multiple words and should be 
descriptive enough to recognize its contents. Visio automatically assigns the .vsd extension.  
 
To save a new drawing: 

1. Click the Save button  on the Standard toolbar. The Save As dialog box opens. 
2. In the Save in: drop-down list, specify a location to save the file (e.g., personal flash 

drive). 
3. In the File name: text box, rename the file or leave the default file name. 
4. Click the Save button. 
  

NOTE: The following characters cannot be used in file names: forward slash (/), backslash (\), 
greater than sign (>), less than sign (<), asterisk (*), quotation marks (“ ”), question mark (?), 
pipe ( | ), colon (:), or semicolon (;). 

ADDING AND DELETING PAGES 
When a new drawing is created, Visio provides only one page. Users can add or remove as many 
pages as desired in the drawings. The added pages, which use the attributes of the page currently 
displayed, are always added to the end of the drawing. 
 
To add a page to the drawing: 

1. Right-click the Page-1 tab at the bottom of the drawing page. 
2. Click Insert Page…. The Page Setup dialog box opens (see Figure 8). 
3. Next to Type:, select the Foreground option button. 
4. In the Name: text box, type a new name or leave the default name. 
5. Click the OK button. 
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Figure 8 – Page Setup Dialog Box (Page Properties Tab) 

 
To delete a page from the drawing: 

1. Right-click the tab of the page you want to delete. 
2. Click Delete Page. 

Working with Shapes 
Shapes, the most important elements in Visio, are stored in stencils. To create drawings, users 
can either use the shapes that Visio provides or create their own personal shapes. 

SELECTING SHAPES 
To select a shape in a Visio drawing, users can simply click on the shape. To select a filled 
shape, users can click inside the shape. To select an unfilled shape, users must click the border of 
the shape. Once selected, a green selection frame with handles appears to show that the shape is 
selected.  
 
More than one shape can be selected at a 
time by pressing the [Shift] key. To select 
all of the shapes, press the [Ctrl+A] key 
combination. As the shapes are selected, all 
shapes become enclosed in a green rectangle 
called a selection box. Green handles appear 
at the corners and sides of the selection box. 
The selected shapes are outlined in magenta, 
and the first selected shape of the group has 
a bolder outline (see Figure 9).  
 

 
Figure 9 – Selecting Multiple Shapes 
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To select multiple shapes:  
1. Open the “shape.vsd” file. 
2. Click the Square shape  at the bottom of the drawing page. 

3. Hold down the [Shift] key and click the Star shape  at the top of the drawing. 
 
NOTE: To deselect a shape, hold down the [Shift] key and click the shape that needs to be 
removed from the selection. The selection box reduces in size to exclude the removed shape. To 
deselect all of the shapes, click in a blank area of the drawing page or press the [Esc] key. 

MOVING SHAPES 
Moving a shape in Visio is done by simply dragging the shape to the desired position. When the 
shape is dragged, the horizontal and vertical rulers display the shape’s top, middle, and bottom 
points on the ruler with faint, dotted lines. Holding down the [Shift] key while dragging a shape 
limits dragging to horizontal or vertical movements. 
 
To move a shape: 

1. Drag the Triangle shape  to a position approximately one inch above the Square 
shape . 

2. Hold [Shift] and drag the Triangle shape horizontally one inch to the left. 
3. Press the down arrow [] and the right arrow [] keys on the keyboard as necessary to 

position the Triangle shape on top of the Square shape. 
 
NOTE: Users can reposition the shape to the desired location in small increments by pressing the 
up [], down [], left [], or right [] arrow keys on the keyboard. 

COPYING AND PASTING SHAPES 
To duplicate shapes, simply use the Copy and Paste features. The Copy feature is similar to the 
Cut feature, except that the Copy feature does not remove the shape from the original location. 
 
To copy and paste a shape: 

1. Click the Star shape  at the top right corner of the drawing. 
2. Click the Copy button  on the Standard toolbar. 
3. Click the Paste button  on the Standard toolbar to place a copy of the shape on the 

drawing page. 

SIZING SHAPES 
After clicking a shape, users can drag a side handle to adjust the shape’s width, a top or bottom 
handle to adjust the shape’s height, and a corner handle to adjust the height and width at the 
same time. Dragging a corner handle maintains a shape’s height-to-width proportions. 

 
NOTE: When the shape is resized, the status bar at the bottom of the screen displays the shape’s height 
and width as users move the mouse. This feature is useful if the shape needs to be a specific size. 
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To resize a shape: 

1. Click the Star shape  at the top right corner of the drawing. 
2. Point to the bottom left corner sizing handle of the Star shape. 
3. Drag the bottom left corner sizing handle until the Star shape is approximately 1/2 inch 

high by 1/2 inch wide. 
4. Click in a blank area of the drawing page to deselect all shapes. 

DELETING SHAPES 
To delete a shape, it must first be selected. Shapes can be deleted one at a time or several at once. 
If a shape is selected, the entire shape and any text contained within the shape will be deleted. 
However, if only the text within a shape is selected, then only the selected text is deleted. 
 
To delete a shape: 

1. Click the Star shape  at the top right corner of the drawing. 
2. Press the [Delete] key. 

ROTATING SHAPES 
Most of the shapes in Visio can be rotated to a desired angle. After selecting a shape, a round, 
green rotation handle  appears outside the perimeter of the selection frame, along with selection 
handles. When pointing to the rotation handle, the mouse pointer changes into a single, curved 
arrow. Dragging the rotation handle in a circular motion will rotate a shape.  

 
NOTE: When the shape is rotated, the status bar at the bottom of the screen displays the angle of rotation 
in degrees. This visual guide is useful if users want to rotate several shapes to the same angle. 
 
To rotate a shape: 

1. Click the Triangle shape . 
2. Drag the rotation handle to the left until a 45 degree angle is reached. 
3. Click in a blank area of the drawing page to deselect the shape.  

Working with Text 
Visio allows users to enhance drawings by adding text. All text in a Visio drawing is contained 
in a text block (see Figure 10). When moving a shape with text, the text block automatically 
moves with it. 

ADDING TEXT TO SHAPES 
Visio automatically expands the width of the text block as text is added. Pressing the [Enter] key 
begins a new line of text. Visio automatically enlarges the length of the text block when more 
text is entered than the selected shape can hold. 
 
To add text to a shape: 

1. Open the “party1.vsd” file. 
2. Double-click the Road shape next to the building at the bottom right of the drawing page. 
3. Type [Main], press the [Enter] key, and type [Avenue] (see Figure 10).  
4. Click in a blank area of the drawing page to deselect the text block. 
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Figure 10 – Adding Text to Shapes 

ADDING FREESTANDING TEXT 
Visio allows users to create freestanding text which is text that is not associated with any shape. 
Freestanding text can be used to enter titles, lists, callouts, footers, etc. Even though freestanding 
text is not attached to a shape, it is enclosed in a text block (see Figure 11).  
 
When using the Text Block Tool to create a text block, the text automatically word-wraps to 
preserve the width of the text block. However, the height of the text block expands as needed. To 
create a text block for freestanding text, either drag to create a text block which fits a specific 
area, or click in the drawing and allow Visio to insert a text block with a default width. 

 

 
Figure 11 – Freestanding Text Block in a Drawing 

 
To add freestanding text: 

1. Click the Text Tool button  on the Standard toolbar.  
2. Click and drag the mouse in the top right corner of the drawing to draw a text block 

approximately 4 inches wide by 1 inch high. 
3. Type [Directions to Cathy’s Party], press the [Enter] key, and type [Starts at 4:00 

PM]. 
4. Click in a blank area of the drawing page to deselect the freestanding text block. 
5. Click the Pointer Tool button  on the Standard toolbar to deactivate the Text Tool 

button . 
6. Double-click the freestanding text. Notice that the whole text is automatically selected. 
7. Click in a blank area of the drawing page to deselect the freestanding text block. 
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Connecting Shapes 
Connectors in Visio are used to connect shapes to each other (see Figure 12). Connectors can be 
lines, arcs, arrows, hubs, cables, etc. These are used to reflect items such as a path in a process, a 
relationship between shapes, or a hierarchy. Connectors can be created using the Connector 
Tool or AutoConnect. 
 

 
Figure 12 – Connected Shapes 

USING THE CONNECTOR TOOL 
One of the most flexible ways to add and glue a connector is to draw it by using the Connector 
Tool. This tool allows users to create a point-to-point or a shape-to-shape connection between 
shapes. With a point-to-point connection, the connector stays glued to the same connection 
points when one of the shapes is moved. With a shape-to-shape connection, the connector stays 
glued to each shape by moving to the closest available connection points when either one of the 
shapes is moved. 
 
To create a point-to-point connection: 

1. Open the “hire.vsd” file. 
2. Click the Connector Tool button  on the Standard toolbar.  
3. In the first row of shapes, drag from the right connection point  on the first Process 

shape  to the left connection point on the Document shape . The connector 
endpoints turn red  when the shapes are connected (see Figure 13). 

4. Click the Pointer Tool button  on the Standard toolbar to return to normal editing. 
5. Drag the Process shape to a new location. Notice that the connector stays glued to the 

same connection points. 
6. Click in a blank area of the drawing page to deselect the shape. 

 

 
Figure 13 – Point-to-point Connection Using the Connector Tool 
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To create shape-to-shape connection: 
1. Click the Connector Tool button  on the Standard toolbar.  
2. Point to the center of the Decision shape  in the first row until a red box appears 

around the shape. 
3. Hold down the mouse button and drag to the center of the Process shape  in the third 

row (see Figure 14). When a red box appears around the Process shape, release the 
mouse button. 

4. Click the Pointer Tool button  on the Standard toolbar to return to normal editing. 
5. Drag the Decision shape to a new location. Notice that the connector stays glued to each 

shape by moving to the closest available connection points. 
6. Click in a blank area of the drawing page to deselect the shape. 

 

 
Figure 14 – Shape-to-shape Connection Using the Connector Tool 

USING AUTOCONNECT  
The quickest way to add and glue connectors to two shapes is to use AutoConnect. Users can 
use AutoConnect while dragging shapes from a stencil onto the page, or to connect shapes that 
are already on the page. AutoConnect can only be used to create a shape-to-shape connection 
between two shapes. 
 
To connect shapes that are already on the page: 

1. Point to the Document shape  in the third row. 
2. Position the pointer over the blue connection arrow that is closest to the Decision shape 

 to the right of it. The arrow turns dark blue and a red box appears around the 
Decision shape (see Figure 15). 
 
NOTE: If a red box does not appear around the shape that you want to connect to, the shape may 
be too far away. Move the shape closer and try again, or use the Connector Tool. 
 

3. Click the blue connection arrow . A connector is added and glued to both shapes. 
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Figure 15 – Shape-to-shape Connection Using AutoConnect 

 
To connect shapes by dragging them onto the page: 

1. In the Shapes pane, select the Basic Flowchart Shapes (US units) stencil, if necessary. 
2. Drag the Process shape  from the stencil onto the drawing page and position it over 

the bottom blue connection arrow of the Document shape  in the third row (see 
Figure 16). The arrow turns dark blue. 

3. Release the mouse button. The shape is placed on the drawing page, and a connector is 
added and glued to both shapes. 
 

  
Figure 16 – Shape-to-shape Connection by Dragging Shapes 
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Grouping Shapes 
Users can group together various shapes and treat them as one unit. This feature is useful when 
moving shapes to a different location. For example, when moving ten shapes to the top of the 
drawing page, it would be time-consuming to move them one-by-one and to maintain the 
previous alignment. 

GROUPING AND UNGROUPING SHAPES 
Visio allows users to group shapes, providing a way to move around shapes while preserving the 
spacing and alignment between each shape. After grouping shapes, users can flip, rotate, and size 
a group of shapes as a single unit. If desired, users can then ungroup the shapes and return them 
to their original independent state. 
 
To group and ungroup shapes: 

1. Open the “group.vsd” file. 
2. Click the View menu, point to Toolbars, and then click Action. The Action toolbar 

displays (see Figure 17). 
 

 
Figure 17 – Action Toolbar 

 
3. Hold down the [Shift] key and click the Room shape at the top left of the drawing page, 

the Mutli-chair round table, each Desk chair, and the three Small plant shapes  
(see Figure 18). 

 

 
Figure 18 – Grouping Shapes 
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4. On the Action toolbar, click the Group button . 
5. Drag the grouped shape to a new location. Notice that all the shapes in the group move 

together. 
6. Click the grouped shape consisting of four Corner surface shapes at the bottom right of 

the drawing page. 
7. On the Action toolbar, click the Ungroup button . Each Corner surface shape can 

now be moved individually. 
8. Click in a blank area of the drawing page to deselect the shapes.  

 
NOTE: Users can also use the [Ctrl+Shift+G] key combination to group shapes and the 
[Ctrl+Shift+U] key combination to ungroup shapes.  

ADDING A SHAPE TO A GROUP 
After grouping shapes, users may want to add more shapes to the group. Visio allows users to 
add additional shapes to an existing group. 
 
To add a shape to the group: 

1. Drag the Plant shape  from the Office Accessories stencil to the center of the 
grouped shape at the top left of the drawing page.  

2. Click the grouped shape at the top left of the drawing page, hold down the [Shift] key, 
and click the Plant shape. 

3. Click the Shape menu, point to Grouping, and then click Add to Group. The Plant 
shape is now part of the group. 

4. Drag the grouped shape to a new location. Notice that the Plant shape moves with the 
group. 

5. Click in a blank area of the drawing page to deselect the shape.  

REMOVING A SHAPE FROM A GROUP 
Users can remove a shape from a group if desired. When removing a shape from a group, the 
shape still remains in the drawing, but is no longer part of the group. The shape can then be 
moved by itself without the other shapes of the group being affected. 
 
To remove a shape from the group: 

1. Click the grouped shape at the top left of the drawing page. 

2. Click the Plant shape  in the middle of the grouped shape. 
3. Click the Shape menu, point to Grouping, and then click Remove from Group. The 

Plant shape is no longer part of the group. 
4. Drag the Plant shape to a new location. Notice that the Plant shape moves independently 

from the group. 
5. Click in a blank area of the drawing page to deselect the shape. 

Printing 
Visio allows users to print the entire drawing or just a part of the drawing. Before printing, it is 
helpful to preview a drawing to verify what will be printed. 
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PREVIEW A DRAWING 
Before printing, users can use the Print Preview function to see how each drawing will appear 
on the printed page. Print Preview displays the page to fit the screen (see Figure 19). When the 
mouse pointer is positioned over the page, it changes into a magnifying glass. When users click 
the page with the magnifying glass, the magnification increases; when clicked again, the 
magnification decreases and the page returns to full view. 
 
If a drawing contains more than one page, users can preview the additional pages by clicking the 
Next Tile button or by clicking the desired page tab at the bottom of the window. 
 
To preview a drawing: 

1. Open the “party2.vsd” file. 
2. Click the Page-1 tab, if necessary. 
3. Click the Print Preview button  on the Standard toolbar. 
4. Click the Next Tile button  to preview the next page. 
5. Click the Previous Tile button  to preview the previous page. 
6. Click the Close button to close Print Preview. 

 

 
Figure 19 – Previewing a Drawing in Print Preview 

PRINTING PART OF A DRAWING 
Users can print a portion of a drawing. For example, if a drawing contains many shapes, users 
can choose to print only the shapes they want to review. 
 
To print a part of a drawing: 

1. Click the House shape  at the top left of the drawing page, hold down the [Shift] key, 
and click the ABC Store shape  at the bottom right of the drawing page. 

2. Click the File menu and select Print…. The Print dialog box opens. 
3. Under Page range, click the Selection option button. 
4. Click the OK button. 
5. Click in a blank area of the drawing page to deselect the shapes. 
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Closing a Drawing 
Once users finish working on a drawing, they can close it to remove it from the application 
window. When closing a drawing, Visio prompts users to save the file if there are any recent, 
unsaved changes made to it. 
 
To close a drawing: 

1. Click the File menu and select Close. 

Exiting Visio 
When users finish using Visio, they should properly exit the application. This allows Visio to 
perform necessary housekeeping before it closes. If the current drawing has been modified but 
not saved, a Visio dialog box or the Office Assistant prompts users to save the changes before 
exiting. 
 
To exit Visio: 

1. Click the File menu and select Exit. 
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